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1 Introduction

STEPS is a multi-function program for measuring the frequency response, distortion vs. amplitude,
and linearity testing of electronic or electro-acoustic devices. Additional features include loudspeaker-
specific tests such as voice coil peak displacement (Xmax), distortion vs. displacement and distortion
limited maximum SPL. Low frequency box diffraction scaling is included as useful tool for the
loudspeaker designer.

STEPS uses a heterodyned stepped-sine technique. Compared to the Fourier analyzer that uses a
wideband noise excitation, this technique gives a larger dynamic range (at least 30dB), but
measurements are much slower. This program is also useful for measuring harmonic distortion as it
estimates the linear part of the system response and the magnitude of distorted sine harmonics.

1.1 Requirements

Minimum requirements to use STEPS are:

o Operating systems: Windows Vista/7/8/10/11

o Processor class Pentium, clock frequency 1 GHz or higher, 2 GB for 32bit Windows or 4GB
for 64bit Windows

o Full duplex soundcard with synchronous clock for AD and DA converters

o WDM or ASIO soundcard driver (ASIO is trademark and software of Steinberg Media
Technologies GmbH).

The Installation of this software is easy; use ARTA installation program or just copy the
program "steps.exe" and the help file "steps.chm™ in some folder and make a shortcut to it. All registry
data will be automatically saved at the first program execution.

Files with extension ".HSW" are registered to be opened with the program STEPS. They contain the
frequency response data. Results of measurements can also be saved as textual - ASCII formatted
files.

STEPS does not output graphs to the printer, instead all graphs can be copied to the Windows
Clipboard and pasted to other Windows applications, or saved to graphics file (.bmp, .png).

1.2 Measurement Hardware Setup

In this document, we refer to the following measurement setups:

1. Dual channel measurement setup
2. Single channel measurement setup

The general measurement setup for the system testing is shown in Fig. 1.1. The soundcard left line-
output channel is used as a signal generator output. The left line-input is used to measure a D.U.T.
output voltage and the right line-input is used to measure a D.U.T. input voltage. In a single channel
setup, only a D.U.T. output voltage is recorded. The setup for acoustical measurements is shown in
Fig. 1.2.
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Figure 1.1 General measurement setup for the system response testing

Left out

power amplifier

[ ] microphone

loud k
soundcard voltage probe oudspeaker

Right input |- ﬁl—l
Lo ] <]«

preamplifier

Figure 1.2 Measurement setup for acoustical measurements

To protect the soundcard input from a high voltage that may be generated at the power amplifier
output, it is recommended to use the voltage probe circuit with Zener diodes, as shown on Fig. 1.3.
Values of resistors R1 and R2 have to be chosen for arbitrary attenuation (i.e. R1=8200 and R2=910
ohms gives a probe with -20.7 dB (0.0923) attenuation if the soundcard line input has usual input
impedance - 10k Q). In a single channel mode this probe is not connected.
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Output Zener Input
41
o x o

Figure 1.3 Voltage probe with soundcard input channel overload protection



1.3 Heterodyned Measurement of Sine Response

The idea of a heterodyned measurement of a sinusoidal response is as follows.

We assume that a time-invariant system is excited with a sinusoidal signal g(t) of known frequency,
amplitude and phase. At the output of the system we measure a noisy and distorted signal y(t);

y(t) = Asin(at + @)+ i A sin(kat + @, ) + n(t)

k=2

A1 is the amplitude of the base sinusoid (or base harmonic), ¢1 is a phase of the base sinusoid, n(t) is
a noise and Ax is a amplitude of k-th harmonic (distortion).

We want to estimate the amplitude and the phase of harmonic components with a minimal noise
influence. We can achieve that by using a heterodyned technique; we extract k-th harmonic component
from y(t) by multiplying it with a complex form of the input signal that has known frequency ;

g, (t) =sin(kat) + jcos(kat) = je I, i=12,..

and integrating the product y(t) gx(t) in a time T. What we get is k-th signal harmonic filtered with a
heterodyne filter of bandwidth equal to 1/T. The former procedure is equivalent to the estimation of
the k-th harmonic component by the Fourier series expansion:

A A

T T
Co=j %I y(t)e *dt = —-cosg + j ?sin P+ ] %J‘(other __harmonics + noise)e ™! “'dt
0 0

Note: the multiplication with j is arbitrary; that way we get the proper phase estimation.

An exact solution is possible only if there is no noise and if the integration time T is equal to the
multiple of 1/w. In that case, the integral term of other_harmonics is equal to the zero and we estimate
the amplitude and the phase by the expression:

A = 2\/Re(ck)2 +1Im(c, )?

Im(ck))
Re(c,)

@, = arctan(
In the presence of the noise, we have a biased estimation, but that bias will be very small if we apply a
long integration time that gives a small bandwidth of a heterodyne filter.

To calculate the Fourier series integral we can use some numerical integration algorithm; the simplest
is the Discrete Fourier Transform.

In a discrete domain, the condition that integration time is a multiple of a sinusoid period cannot be
fulfilled, and we have a "leakage" in the spectral estimation. The usual technique to suppress the
leakage is to apply the window function w(t). STEPS uses the Kaiser window.

STEPS shows the distortion of sinusoidal signal induced by n-th harmonic component as a percentage
of harmonic distortion (%) or a harmonic distortion level in dB:

Dn (%) =100 (An/A1) - percentage of n-th harmonic distortion



Dn (dB) = 20 log(An/A1) - distortion level of n-th harmonic component
STEPS shows the Total Harmonic Distortion of a sinusoidal signal as :

THD (%) = 100 sqrt((As2+As?+...A12%) 1A?)

THD (dB) = 10 log((A2?+As%+...A12%) IAL?)

Fig. 1.4 shows STEPS PC based measuring system. The computer generated signal g, after D/A
filtering with a transfer function D, is applied to the test system that has a transfer function H. Note
that H represent the best linear fit of a possible nonlinear transfer function. The generator noise is
neglected. The output from the test device, together with an additive system noise n, is acquired by the
computer as a discrete signal sequence y. The acquisition process implies the use of an antialiasing
filter that has a transfer function A.

MNoise
D/A filter ;;{L A/D filter
o D H +) A =3

D.U.T

Figure 1.4 Block diagram of measuring system

Note: In acoustical measurements we ignore the influence of the generator noise and the noise in the
input channel x, as they are much smaller than the noise and distortion in the output channel y.
In a dual channel mode the input to the test device is acquired by the computer as a discrete signal
sequence x. The output from test device is acquired by the computer as a discrete signal sequence y.
Then the D.U.T frequency response is,

Magnitude(H) = Magnitude(Y) / Magnitude(X)

Phase(H) = Phase(Y) - Phase(X)
This mode is also called frequency response mode or ratio mode.
In a single channel mode the signal at a system input is not measured and the signal g from -
computer memory - is treated as a system excitation. Now the estimated frequency response includes
response of A/D and D/A filters;

Estimated Magnitude(H) = Magnitude(Y) = Magnitude(DHAG)

Estimated Phase(H) = Phase(Y) = Phase(DHAG)

This mode is also called a level mode, as STEPS actually shows level at the measured system output.

For both measurement modes the time relationship between the excitation signal and analyzed signals
is illustrated in Fig. 1.5.
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Figure 1.5 Time relationship between the excitation signal and analyzed signals
The user has to define several measurement parameters:

o range of frequencies for the excitation signal,

o frequency increment between two measurements (in STEPS user chooses: 1/6, 1/12, 1/24 or
1/48 octave frequency increment)

o 1/O delay in a measured system (i.e. delay from loudspeaker to microphone),

o integration time for heterodyne filtering (common values are from 100 ms to 1 s),

o transient time that is necessary to reach a steady-state condition (in acoustical measurements,

if we want to measure the influence of reverberation, the transient time should be greater than
one-fifth of the reverberation time),

o duration of pause between two successive sine bursts (in acoustical measurements duration of
intra-burst pause should be greater than one-fifth of the reverberation time)

Note: the criteria that transient time should be greater than one-fifth of the reverberation time assures
that the magnitude error will be lower than 1 dB.

The measurement procedure is as follows:

1. Start measurements with burst of sine signal of known frequency and
¢ insingle channel mode record the system output signal,
e in dual channel mode record system input and output signals.

2. Acquire the steady state response, after the transient and 1/0O delay time. Calculate the magnitude
and the phase of the frequency response, and magnitudes of harmonic distortion, using Fourier
transform.

3. Increment the working frequency. If that frequency is inside the user-defined range, wait for the
predefined intra-burst pause time and then repeat the step 1.

For all above operations STEPS has a suitable user interface. That interface will be described in the
next chapter.
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2 Using STEPS for stepped-sine testing

STEPS has the main program window as shown in Fig. 2.1. A menu bar and a toolbar are on the top of
the window and a status bar is on the bottom of the window. The central part of the window shows the
magnitude and the phase plot. The control bar on right side of window is used for graph margin setup.

Untitled - Steps

File Owerlay Edit View Record Setup Help
I.'ir"'n‘f.“l|l" n E|bl E‘Eﬂ-‘.|MagPhM+PM+DD%
Start{Hz) II' = Stop{Hz) = Step |1fsoct ~ Delay(ms)lzl Autoovr [
Top
. FR magnitude (dB Vi) -
- =
E Fit
10.0 P
S
Range
0.0 *
-10.0 set
200 FrHigh
4 F
-30.0 m Magn Frlow
20 S0 100 200 500 1k 2k sk 10k 20k a|[v
FiHz}
Ready L:-100.0  R:-100.0  dBFS
Figure 2.1 Main program window
Open Copy to Thick Start Measurement FR View Magnitude
file clipboard lines recording setup compensation magnitude + distortion

. 2R 2R 2 2 . |

= E‘[ZII‘V n Elb I‘L\X‘-:n-‘ﬂ‘wlag Ph M+P M+D D%

P r ottt

Save Background Thick Stop Audio View View Magn. View %
file color grid recording devices signal phase +phase distortion

Figure 2.2 Toolbar icons



Ready L:-100.0 | R:-100.0 | dBFS

Figure 2.3 Status bar shows peak level (ref. full scale) of left and right line inputs

Start Stop Frequency Delay for Automatic
frequency frequency increment phase estimation overlays

Start(Hz}: Stop(Hz) | 20000 |5+ Step |1f12oct. v Dela';[ms} AutoOvr []

Figure 2.4 Dialog bar

Top
: Changes graph top magnitude margin
F Fit plotted curve to graph top magnitude margin
Range
- Changes graph magnitude range
Set Opens dialog box for the setup of graph margins
FrHigh
S Changes graph high-frequency margin
FrLow
1 Changes graph low-frequency margin

Figure 2.5 Top and right dialog bars

Images of graphs and windows can be copied to Windows clipboard or saved to the file in a three
image formats: png, bmp and jpg. It is recommended to use png format.

Obtaining a copy of the full window picture is simple. User needs to simultaneously press keys
Ctrl+P. After that command the window picture will be saved in the System Clipboard, from there the
user can paste it in other opened Windows applications (MS Word, MS Paint). Keys Ctrl+Alt+P
activate command to save that image in the file.

To copy or save the graph picture, that is shown inside the window, user needs to simultaneously press
keys Ctrl+C or activate the menu command 'Edit->Copy"', or press appropriate 'Copy' button. In the

main window toolbar, the 'Copy' button is shown as toolbar icon
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Copy / 5ave Image with EBxtended Information

Enter text that will be appended on the bottom of the graph copy

Bitmap size Current screen size v Copy to Clipboard
Aspect ratio 3:2 b Add filename and date [ ]
Cancel

Save text [ ]

Figure 2.6 Dialog box 'Copy / Save Image with Extended Information’,

The Copy command opens the dialog box 'Copy/Save Image with Extended Information', shown in

Figure 2.5. Here user has to setup following options:

1)

2)

3)

4)
5)

6)

By using the combo box above ‘OK’ button, user chooses one of three modes of
saving the image: Copy to Clipboard, Save to File and Save to File + Copy to
Clipboard.

In the Edit box user optionally enters the text that will be appended at the bottom of
the graph.

Check box ' Add filename and date' enables adding text to the graph that shows file
name, date and time.

Combo box ‘Aspect ratio’ sets graph aspect ratio to 3:2 or 2:1.
Check box 'Save text' enables saving entered text for the next copy operation.

Bitmap size is chosen by selecting one of following combo box items:
= Current screen size - variable width and height option

= Smallest - fixed graph width 500 points
= Small - fixed graph width 600 points
= Medium - fixed graph width 800 points
= Large - fixed graph width 1000 points
= X lLarge - fixed graph width 1200 points
= XX Large - fixed graph width 1500 points

= XXX Large - fixed graph width 2000 points
The button 'OK’ copies the graph to the system clipboard or opens dialog to enter

name of file in which picture will be saved.
The button 'Cancel’ cancels the copy operation.
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2.1 STEPS Menus

Here is a brief explanation of all Steps menus:

File

New - Creates a new file

Open... - Opens an existing file (*.HSW)
Save - Saves the file with current name
Save As... - Saves the file under a new name

Export ASCII - Exports the file in ASCII format:
Magnitude + Phase (commented . TXT) - text file with comment text and with rows
containing frequency (Hz), magnitude (dB), and phase (deg),
Magnitude + Phase (plain .FRD) - text file with rows containing frequency (Hz), magnitude (dB),
phase (deg),
Magnitude + distortion (. TXT) - text file with rows containing frequency (Hz) and percentage
distortion for THD, 2nd, 3rd and higher order harmonics,
Magnitude + Phase (.CSV) — CVS (Excel) file containing frequency (Hz), magnitude (dB), and
phase (deg),
Magnitude + distortion (.CSV) - CVS (Excel) file containing frequency (Hz) and percentage
distortion for THD, 2nd, 3rd and higher order harmonics.

File Info - shows information of currently opened file.
Recent File - opens a recently opened file.
Exit - exits program.

Overlay

Set - sets the current measured FR curve as an overlay.

Manage overlays — opens the 'Overlay Manager' dialog box for editing of the overlay’s list.
Delete all - deletes all overlays.

Delete last - deletes last entered overlay overlays.

Load - loads an overlay from STEPS (.hsw) file.

Load impedance overlay - loads impedance overlay from .zma or .lim file.

Delete impedance overlay — deletes loaded impedance overlays.

Edit

Undo - undoes last state.
Copy - copies the graph bitmap and user defined text to the clipboard or saves that image to the file.
Colors and grid style - sets graph colors and grid plotting style.
B/W Color - changes the background color to black or white.
Thick pen - sets pen style to draw thick lines.
Thick grid - sets pen style to draw thick grid.
Smooth Magnitude - Power smoothes magnitude in band.
1/1 octave,
1/2 octave,
1/3 octave.
Scale level - scales the magnitude level.
LF box diffraction - scales the frequency response with response of loudspeaker box LF diffraction.
Cut below cursor - cuts plotted points below the cursor position.
Cut above cursor - cuts plotted points above the cursor position.
Apply FR compensation — applies current FR compensation to loaded STEPS data.
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View

Toolbar - shows or hides the toolbar.
Status Bar - shows or hides the status bar.
Fit graph top - fits graph top margin to maximum magnitude.
Time Record - shows the time record of the last recorded signal.
Percentage distortion - shows window with log-log plot of percentage distortion.
Magnitude - shows the magnitude.
Phase - shows the phase.
Magnitude+Phase - shows the magnitude and the phase.
Magnitude+Distortion - shows the magnitude, 2nd and 3rd harmonic distortion.
Sound pressure units - sets the sound pressure unit if the microphone input is enabled to:
dB re 20 uPa/V
dB re 20 uPa/2.83V
dBre 1 Pa/V

Record

Run - starts recording (measurement).

Stop - stops recording (measurement).

Distortion vs. amplitude - opens dialog for stepped amplitude distortion testing.

Linearity function - opens dialog for stepped amplitude 1/O linearity testing.

Distortion and Displacement - opens dialog for stepped amplitude measurement of displacement.
Loudspeaker distortion limited SPL - opens dialog for measurement of distortion limited SPL

Setup

Audio devices - sets current input and output devices.

Calibrate devices - calibrates the soundcard and the microphone.

FR compensation - gets dialog box for frequency response compensation.
Measurements - configures measurements.

Graph - sets graph margins.

CSV format - sets decimal separator character for CSV files (dot or comma).

Help

User Manual - shows the help file.
Registration - shows license registration info.
About... - shows information about STEPS version.

Useful shortcuts keys are:

Up and Down keys - change the top graph margin.

Left and Right keys - move the cursor left and right.

Ctrl+S key - saves the file.

Ctrl+N key - makes a new file.

Ctrl+O key - opens the file.

Ctrl+C key - copies the graph bitmap and user defined text to the clipboard or saves that image to the file
Ctrl+P key - copies a whole window bitmap to the clipboard
Ctrl+Alt+P key - saves a whole window bitmap to the file
Ctrl+B key - changes background color.

Ctrl+A key - sets currently plotted curve as overlay.
Ctrl+M key - opens overlay manager window.

12



STEPS User Manual

2.2 Audio Devices Setup

Before you start measuring you have to set up your hardware and audio devices by clicking the menu
‘Setup->AudioDevices' or by clicking the toolbar icon =% You will get the dialog box for the audio
devices setup shown in the Fig. 2.6.

Audio Devices Setup *

Soundcard
Soundcard driver  |\WDM - Windows multimedia driver Contral Panel

Input channels Line In (Scarlett 2i2 USE)

Wave Farmat

Qutput chanrels | Line Qut (Scarlett 2i2 USE) e 16-hit

Input Qutput
LineIn Sensitivity

(mVpeak - Left ch)
LR charnel diff. (d8) E

LineQut Sensitivity

1000
(mVpeak - Left ch)
Power amplifier gain

External preamplifiers Microphone

Left preamplifier gain Lsed on Left Ch w

Right preamplifier gain Sensitivity (mV/Pa) 100
Save setup Load setup Cancel

Figure 2.6 Dialog box for audio devices setup

The "Audio Device Setup' dialog box has following controls:

In section Sound Card:

Soundcard driver - chooses the type of soundcard driver (WDM — windows multimedia driver or one of
installed ASIO drivers).

Input channels - chooses the soundcard input stereo channels. ASIO driver can have large number of
channels.

Output Device - chooses the soundcard output stereo channels.

Generally, user chooses input and output channels of the same soundcard (mandatory in ASIO driver
mode).

Control panel button — if WDM driver is chosen, it opens sound mixer on Windows 2000/XP or Sound
control panel in Vista/Win7. If ASIO driver is chosen, it opens ASIO control panel.

Wave format — chooses Windows wave format: 16-bit, 24-bit, 32-bit or Float. Float means IEEE floating
point single precision 32-bit format. It is recommended to use 24-bit or 32-bit modes when using a high
quality soundcard (many soundcards are declared as 24-bit, but their real bit-resolution is less than 16-bits).
It is recommended to choose resolution type ‘Float’. This control has no effect in the ASIO mode, where a
bit resolution has to be setup in the ASIO control panel.

In section Input:
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Lineln sensitivity - enters the sensitivity of the line input (i.e. peak voltage in mV that corresponds to the
full excitation of the line input).

LR channel diff. - enters the difference between the sensitivity level of the left and the right input channels
in dB.

The best way to enter these values is to follow the calibration procedure as described in the next chapter.

In section Output:

LineOut sensitivity - enters the sensitivity of the left line output (i.e. peak voltage in mV that corresponds
to the full excitation of the line output).

Power amplifier gain - enters the power amplifier voltage gain if you connect the power amplifier to the
line-output, and you need calibrated results in a single channel measurement setup, Otherwise set gain to 1.

In section External preamplifier:

Left preamplifier gain - If you connect a preamplifier or voltage probe to the left line input you should
enter the gain of the preamplifier or probe attenuation in the edit box, otherwise set it to unity gain.

Right preamplifier gain - If you connect a preamplifier or voltage probe to the right line input you should
enter the gain of the preamplifier or probe attenuation in the edit box, otherwise set it to unity gain.

In section Microphone:
Microphone used on - check box if you use the microphone and want the plot to be scaled in dB re 20 pPa
or dB re 1 Pa. Also, use combo box to choose the channel where the microphone is connected (we strongly
recommend to use the soundcard left channel as a microphone input channel).
Sensitivity - enters the sensitivity of the microphone in mV/Pa.

The setup data may be saved and loaded, by pressing the buttons 'Save setup' and 'Load setup'. The setup-files
have the extension ".cal'

Important notice: Please mute the line and microphone channels at the output mixer of the
soundcard; otherwise, you might have a positive feedback during measurements. If you use a
professional audio soundcard, switch off the direct or zero-latency monitoring of the line inputs.

Most professional audio soundcards have their own program for adjustment of input and output
channel, or have hardware control of input monitoring, and input and output volume controls.

2.2.1 WDM Audio Driver Setup

The operating system (also, sometimes in conjunction with control programs of professional
soundcards) is responsible for setting soundcard native sampling rate and bit resolution. The operating
system changes native resolution to floating point format for high quality mixing and eventually for
the sample rate conversion.

For ARTA this means that it is strongly recommended to use resolution type ‘Float’ and sets the
sampling rate to the native format. Access to these values is in ‘Windows sound control panel’,
which user gets by clicking the button ‘Control Panel’ in the ‘Audio Device Setup’ dialog.

Fig. 2.7 shows Windows Sound control panel, that has four property pages.
As first step, user has to adjust 'Playback page' and later repeat the same procedure for '‘Recording
page'. Adjustment steps are:

1) Click on channel info to choose a playback channel. It is not recommended to use the
measurement channel as a default audio channel.

2) Click on button ‘Properties’ to opens channel ‘Sound properties’ dialog.

3) Click on the tab ‘Levels’ to open the output mixer (as in Fig. 2.8). Then mute Line In and Mic
channels, if exist.

14
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4) Click on the tab ‘Advanced' to set the channel resolution and a sample rate (as in Fig. 2.9)
5) Repeat previous procedure 1) to 4) for recoding channel and choose the same sampling rate as
in the playback channel.

& sound |
Playback |REcording | Sounds | Communications |

Select a playback device below to modify its settings:

- Speakers
G046 Audio Device
| Ready
Digital Output
a G046 Audio Device

Ready

| Speakers
SoundMAX Integrated Digital HD Audio
0 Default Device

SPOIF Interface
a SoundMaX Integrated Digital HD Audio
Ready

Configure | Set Default |v| Properties I

oK | Cancel | Gpply |

Figure 2.7 Vista Sound Control panel

&) speakers Properties x|

‘General | Custom Levels | System Effects | Advanced |

 Speakers
j = ﬂl Balancel
 Line In
J 0 IE Balance |
~ Microphone
J 0 IE Balance |
J 3 ﬂl Balancel
— CD Player
J 3 ﬂl Balancel

%

Cancel | Apply |

Figure 2.8 Playback channel properties — Output levels
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x

-Generall Cushoml Levelsl System Effects Advanced |

 Default Format

Select the sample rate and bit depth to be used when running
in shared mode,

16 bit, 48000 Hz (DVD Quality) P Test |

 Exclusive Mode

v Allow applications to take exclusive control of this device

¥ Give exclusive mode applications priority

Restore Defaults

oK I Cancel | A |

Figure 2.9 Setting the native bit resolution and sampling rate in Vista

Note: Many drivers do not work stable under Windows 7. In that case, please use ASIO driver if
soundcard has one.

2.2.2 ASIO Driver Setup

ASIO drivers are decoupled from the operating system control. They have their own control panel to
adjust native resolution and memory buffer size. The buffer is used for transferring sampled data from
the driver to the user program. User opens the ASIO control panel by clicking button ‘Control Panel’
in the ‘Audio Device Setup’ dialog. Fig. 2.10 shows an example of ASIO control panel.

Freferences
(1] 4
Buiffer Size: |2|:| iz j —l
Cancel |
Bit Depth; | 32+ =]

[ Per &pplication Preferences
=E-MLU

Figure 2.10 E-MU Tracker Pre ASIO Control panel for setting bit-resolution and buffer size
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In music applications user usually sets buffer size as small as possible for stable operation. That gives
the lowest input/output latency (system-introduced delay).

In STEPS, latency is not a problem, as it is encountered in software, but it is not recommended to use
buffer with size larger than 2048 samples, or smaller than 256 samples. Some ASIO control panels
express the buffer size in samples, while other express the buffer size in time [ms]. In that case, we can
calculate the size in samples using the following expression:

buffer_size [samples] = buffer_size[ms] * samplerate[kHz] / number_of channels.

ARTA automatically sets the buffer size for signal duration of 10 ms (i.e. 512 samples for sample rate
48kHz, 1024 samples for sample rate 96kHz and 2048 samples for sample rate 192kHz).

STEPS always works with two input channels, and two output channels, treating them as a stereo left
and right channels. As ASIO support multichannel devices, user has to choose in a dialog box ‘Audio
Device Setup’’ which pair of channels will be used in STEPS (1/2, 3/4, ...).

Note: ARTA closes and releases ASIO driver when measurement stops, but if driver needs long time
to be loaded in memory, ARTA keeps driver open all the time.
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2.3 Sound Card and Microphone Calibration

Calibration is a process which defines mapping of the internal digital values D[i] to external analog
voltage values VI[i]. Index i denotes signal value sampled at time i / samplerate. For linear system this
mapping is defined with single factor called sensitivity;

Sensitivity = V[i] / D[i], where |D[i]| <=1, i=0,1,2,...
In ARTA software discrete values D[i] are floating point values in the range from -1 to 1. The unit of

sensitivity is the Volt as D[i] is dimensionless. We will also use unit mV. The above definition is also
valid for RMS values of periodic signals;

Sensitivity = Vrms / Drms

Maximum possible value of discrete sequence D[i] is 1. That gives us alternative definition of
sensitivity as maximum peak value of voltage (or full scale value) that can be recorded (or generated)
by digital instrumentation;

Sensitivity = Vpeak_max (Volts).

Menu command Setup->Calibrate devices opens the dialog box 'Soundcard and Microphone
Calibration' shown on Fig. 2.23. That dialog enables setup of sensitivity for soundcard input and
output channels. The same dialog box serves for calibration of microphone sensitivity. Microphone
sensitivity defines mapping of sound pressure on microphone membrane to voltage generated by
microphone. It has unit mV/Pa.

Soundcard and Microphone Calibration

Soundcard full scale output (mv)

1. Connect electronic voltmeter
or scope on left output channel
(setrange to 2V)

2 Generate sine (400 Hz)

Output level -3dB ~

3. Enter voltmeter (scope) value

| 1000 | |m'-a' rms v|

Soundcard full scale input (mVv)

1. Connect sine generator with
known output voltage on

Input channel |Left w

2. Enter voltage (peak or rms)

500 mV rms e

3. | Estimate Peak Input my

Estimated  Current
4, Estimate Peak Output my left | 1000 || 1000 |mv
ER Current Right | 1000 || 1000 |mv
1000 | | 1000 | my  Diff | 0| 0|d8
Accept Accept
L | -7 | 50 | -3 | 10
= -80 | &1 | 40 | -20 | dB

Microphone sensitivity {mv/Pa)

1. Connect microphone on

Input channel || ft -

Preamp. gain
2. Attach sound calibrator

Pressure level dB

3. | Estimate Mic, Sensitivity

Estimated
| 5] |

Accept

S——

48000 v o

Current

5 | mv Pa

Figure 2.13 Dialog box for calibration of soundcard and microphone
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Dialog box has three sections for:
(a) soundcard output left channel calibration,
(b) soundcard input left and right channels calibration, and
(c) microphone calibration.

During calibration sampling rate can be set to 44100 or 48000 Hz, by using combo box at bottom of
dialog box.

2.3.1 Calibration of Soundcard Output Left Channel

It is recommended to follow this procedure:

1. Connect the electronic voltmeter to the left line output channel.

2. Set'Output level' control to -3 dB or less.

3. Click the button 'Generate sine (400 Hz)' and program generates output sine signal with peak
value that is 3 dB below full scale value (or other value set with Output level control). The
button label changes to ‘Stop generator’.

4. Enter the voltmeter readout in edit box (in mV rms). (Note that rms value is 3 dB, or 1.41421
times, lower than peak value). If you read the peak value from scope in the combo box choose
‘mV peak’.

Click the button ‘Stop generator’, then click the button 'Estimate Peak Output mV".
6. The estimated value will be shown in the box 'Estimated'. Following equation is used for
sensitivity:

o

Sensitivity = Maximum Output Peak = 1.41421 * Vrms * 1Q0utput-teveli20

If the generator output level was set to -3 dB this value will be twice the rms voltmeter
readout.

7. If you are satisfied with measurement, click the button 'Accept’, and the estimated value will
become the current value of the 'LineOut Sensitivity'. Also, it will be entered as a value for
the input channel calibration.

Important note: Calibration is valid until we change the output volume control.

2.3.2 Calibration of Soundcard Input Channels

You can use an external sine generator or the output channel of the soundcard to calibrate the input
channels. In both instances you should measure the value of generator output voltage.

In case of using the output channel of the soundcard as a calibrated generator:

1. Set the left line input volume to some value. Start with maximum volume or minimum gain if
soundcard has built in preamplifier. Later you can make calibration for any preamplifier gain.

2. Connect the left output to the left line input channel.

3. Click the button 'Generate sine (400 Hz)' and monitor the input level at bottom peak-meters.
If the soundcard input is clipping, lower the level of input volume. Alternatively, you can
lower the generator level (but, then you need to measure output voltage Vrms again).

4. Enter the value of generator voltage in the edit box (but only if it differs from value used
during output channel calibration (1.5.1)).

5. Click the button 'Estimate Peak Input mV', and program calculate sensitivity as ratio of
Vrms / Drms.

6. If you are satisfied with measurements, click the button 'Accept’, and estimated value will
become the current value of the 'Lineln Sensitivity'.

7. Repeat steps 1-6 for the right input channel.
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This is the recommended procedure as it guarantees that you can connect the soundcard in loopback
mode. If you want to calibrate input channels with input volume control set to maximum, many
soundcards require a reduction of the level of the output channel.

Important note: Calibration is valid until we change the input volume control.

2.3.3 Calibration of the Microphone
For microphone calibration you must have a sound calibrator. Then:

Connect the microphone preamplifier to the soundcard input (left or right).
Enter the preamplifier gain.

Attach the sound calibrator to the microphone capsule and turn on calibrator.
Press the button 'Estimate mic sensitivity'.

If you are satisfied with a measurement, press the button 'Accept’.

agkrwdE

Note: If you don't know the preamplifier gain, you can set some arbitrary gain value (i.e. 1), but that
value must be used as a preamplifier gain in the 'Audio Devices Setup' dialog box.

2.3.4 Frequency Response Compensation

The quality of measurements depends on the quality of used sensors, i.e. microphones. It is possible to
enter frequency response of sensor in STEPS and make the compensation of their frequency response
(by applying the inverse of sensor FR to measured FR).

The menu command Setup->FR compensation or click on icon B8 gets the dialog box "Frequency
Response for Compensation”, shown in Fig. 2.14.

The dialog has a few controls and a graph that shows the frequency response which will be used for
FR compensation.

The button Load opens the dialog for loading ASCII files that contain frequency response data. The
file name must have extension .MIC and data entered in lines of text. Lines that start with a digit or dot
characters must contain at least two values: first value is frequency in Hz and the second value is
magnitude of frequency response in dB. The third value is optional. It may be the value of phase or
any other text that will be treated as comment. All other lines are treated as comment. After
successfully reading of the compensation file, the path of the file will be shown in the box below the
graph.

For example, file shown in Fig. 2.14 has content:

microphone ecm8000
freqg(Hz) Magn (dB)
20.280 0.04
44,930 0.28
49.601 0.61
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B4 Frequency Response for Compensation

Edit
" tude dB Range(dE)
Magnitude
ﬂ
2.0
6.0 Copy
4.0
2.0
0.0 pmrt=r ___J\uﬁ"l v/ J T
-2.0 \ -
\ Show spline
-4.0
Y interpaolated
5.0
data [ ]
2.0
-10.0
10 100 1000 10000
Cursor; 20.0Hz, -0.1 dB F(Hz}
C:'\&rotaudio 1\Arta 192Ycal\ECMB000, mic
Ise frequency response compensation Ok

Figure 2.14 Typical frequency response of an electret microphone.

The check box "Show interpolated values" enables us to see the interpolated FR curve that will be used in FR
compensation.

The button 'Copy" copies current graph picture on Windows clipboard.
The combo list box 'Range (dB)' sets graph magnitude dynamic range (10-100dB).

The button 'Use frequency response compensation’ enables/disables frequency response compensation.
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2.4 Measurement Setup
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For the setup of measurements use the "Measurement setup’ dialog box shown in Fig. 2.15. You get
it by clicking the menu item Setup->Measurement or by clicking the toolbar icon B2

Measurement Setup >

Measurement System
Single channel - Level e

ft o

m

Response channel L

Sampling frequency (Hz) | 43000 e

Min. integration time {ms) 200

Transient time {ms) 200|

I/0 delay {ms)

Stepped Sine Generator

20.00 e
2000000 e

1/12 octave

e

Mute generator switch-off transients

Start frequency (Hz)
Stop frequency (Hz)
Freguency increment

Generator level (dBFS)

Test frequency (Hz)

i

Intra burst pause {ms) 200
Generate Default Cancel (n]4
Set current response as overlay |:| -
L 1 70 I -50 I 1] I 10 dB
R a0 I 80 I 40 I 20 I dB

Figure 2.15 Measurement setup

The 'Measurement setup' dialog box has following controls:

In section Measurement System:
The first combo box chooses mode of measurements:
Dual channel - frequency response measurements,
Single channel - level measurements.
Response channel - chooses the Left or the Right channel.
Sampling frequency (Hz) - chooses the sampling frequency (from 11025 to 192000 Hz).
Min. integration time (ms) - enters the minimal integration time (0 to 2000 ms).
Transient time (ms) - enters the transient time (0 to 2000 ms).
1/0 delay (ms) - enters the estimated constant delay in the measured system.

Intra burst pause (ms) - enters the duration of pause between generation of two sinusoids.

Set current response as overlay — on new measurement automatically sets current curve as overlay.

In section Stepped Sine Generator:
Start frequency (Hz) - enters the starting frequency in Hz.
Stop frequency (Hz) - enters the ending frequency in Hz.
Frequency increment - chooses an increment: 1/6, 1/12, 1/24 or 1/48 octave.
Generator level (dB re FS) - enters the output generator level.
Test frequency (Hz) - enters frequency in Hz for testing 1/0 levels.

Mute generator switch-off transient — suppress sine switch-off transients, but measurement time is

enlarged.
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Button Generate starts generation of test sine signal, and peak meters show input levels.
Button Default sets the default measurement configuration.

Button OK accepts measurement configuration.

Button Cancel rejects changes in measurement configuration.

2.5 Measurement Procedure

If you have done the audio device setup, the generator setup and the measurement setup you are ready
for measurements.

1. Connect voltage probes or other sensors to measured system output. In dual channel mode
connect voltage probes to measured system input.
2. Click the menu item Record->Start or click the toolbar icon * .

3. Measurement will be repeated for logarithmically spaced frequencies and results shown as a
magnitude, phase, magnitude + phase or magnitude + distortion plot. To change the plot type

press one of following icons; | Mag  Ph M:E M0

Note:
You can stop measurements prematurely by clicking the menu Record->Stop or by clicking the

toolbar icon ® .

You can copy the graph bitmap to the clipboard by clicking the menu Edit->Copy or by clicking the
toolbar icon B

The quality of measurement depends on the quality of a soundcard. Fig. 2.16 shows the frequency
response plot of a high quality soundcard EWX 24/96. It is obvious that STEPS can measure
distortion, that is more than 120 dB below the maximum signal level, but actual distortion resolution
depends on the quality of the soundcard used.

. Magnitude dBY

-20.0

-40.0

wmam-o

500
-80.0
-100.0

m D3
-1zu.nmmmpm "0
1400 m lagn
20 50 100 200 500 1k 2k sk 10k 20k

f1208.1 Hz, Magn: -5.79 dB f(Hz)
D2:-107.94, D3:-112.12 dB

Figure 2.16 Typical frequency response plot of a high quality soundcard. The bottom grey curve
shows second harmonic distortion and the red curve shows the third harmonic distortion.
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In acoustical measurement we usually measure much higher level of harmonic distortion. Figure 2.17
shows the frequency response of a small low-quality multimedia loudspeaker.

FR maagnitude dB re 20uPaf/

100.0 g
50.0 T
E
20.0
Fl
70.0 3
60.0
50.0
40.0
30.0
20.0 a3
10.0 m 02
0.0 m Magn
20 =0 100 200 S00 1k 2k ok 10k 20k
f. 358.9 Hz, Magn: 75.90 db fiHz}

D2:-49.59, 03:-50.99 dB
Figure 2.17 Typical frequency response and distortion level of a small multimedia loudspeaker.

You can define the current plot as overlay plot, or you can load an overlay plot. The number of overlay
plots is not limited.

File formats and manipulations are explained in the next section.

2.6 Overlays

The overlay is a curve that is permanently shown besides the currently shown measured curve. The
user can set the current frequency response curve as overlay, he can also define some overlays
to have the crossover target filter response. Manipulations with overlays are handled with
menu Overlay. It has following pop-up items:

Set as overlay - saves the current curve as an overlay.

Manage Overlays - opens dialog box 'FR Overlay Manager'.

Delete all - deletes all overlays.

Delete last - deletes last overlays.

Load - loads overlay from STEPS “.hsw’ file.

Load impedance overlay - loads an impedance overlay from ¢.zma’ or “.lim’ file.
Delete impedance overlay — deletes impedance overlays.

Advanced manipulations with overlays can be done using the dialog box 'FR Overlay Manager’
(shown in Figure 2.18). It is activated by menu command 'Overlay->Manage Overlays'.

In the dialog, some buttons replicate menu commands:

Add overlay - sets current curve as an overlay.
Delete all - deletes all overlays.
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Overlay Colors

Overlay manager |
|
Magnitude response Colar I:l
|
aviL.hsw I
|
avi2.hsw I
|
EEET I . | | eee—
|
|
|
|
|
|
|
I
Add overlay Delete s&l Change color Cancel
Replace sel Delete all Chedk All Cancel

Figure 2.18 Dialog box 'FR Overlay Manager' and dialog box 'Overlay colors'

Other buttons enable advanced operations on selected list box items:

Replace sel - replaces selected overlay with current curve.
Delete sel - deletes selected overlays.
Color - changes color of selected items using the dialog box 'Overlay Colors' shown in Figure. 2.18.

Mouse click on List box item has following effects:

Single click - selects list items.
Single click on check box - makes overlay visible or invisible.
Double click - enables editing of overlay names.

All list items can be set visible by pressing button ‘Check All'.

2.7 File Manipulations

STEPS uses special binary format to keep measured data in files whose names end with extension
HSW.

Besides measured data .HSW files can contain user defined text of arbitrary length. User can enter the
text in the edit box of File Info dialog (see Fig. 2.19). This dialog can be opened by clicking menu
command File->Info.
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ile: avll.hsw

tart frequency: 200.0
top frequency: 20313.5

um frequency paints: 81
um channels: 2

requency increment: 112 octave

icrophone measures system output
icrophone sensitivity: 20.00 my/Pa

User additional infa .|

Figure 2.19 Dialog for viewing and entering file information

The format of binary .HSW file is as follows:

char filesignature([4]

unsigned int version;

int numpoints;

int numdist2;

int numdist3;

if (version >= 0x0103 )
int numdist4

if (version >= 0x0104 )
int numdist5;
int numdist6;

int numchannels;

int resolution;

int smoothing;

int crspos;

int micused;

used on input

float micsens;

float frequency[numpoints];

float magnitude [numpoints];

float phase[numpoints];

float D2[numdist2];

float D3 [numdist3];

if( version >= 0x0103 )
float D4 [numdistd];

if( version >= 0x0104 )
float D5[numdist5];
float D6[numdist6];

float THD[numdist2];
int infotext length;
char info[infotext length];

// four signature characters: 'H','S','W','\0"'
// version of file format

// number of measured frequency points

// number of frequency points for D2 and THDs
// number of frequency points for D3

// number of frequency points for D4

// number of frequency points for D5

// number of frequency points for D6+

// 1 or 2 (channel measurement)

// 24 or 48 of octave

// 1,2,3 of octave

// cursor position

// microphone: 0-not used, l-used on output 2-

// microphone sensitivity V/Pa
// frequency in Hz

// magnitude in dB

// phase in degree

// 2nd harmonic levels in dB
// 3rd harmonic levels in dB

// 4th harmonic levels in dB

// 5th harmonic levels in dB
// 6th plus higher harmonic levels in dB

// THDs levels in dB

// user info text length (in bytes)
// user info text
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Note: Dn denotes n-th harmonic distortion, but D6 also contains power of 7th to 12th harmonic
component. In files version 103, D4 contains power of 7th to 12th harmonic component.

Steps can export data in three textual forms:

1) Magnitude+Phase (commented .TXT) - contains comments lines and lines with data: frequency,
magnitude, phase.

<Steps info>

Start frequency: 200.0

Stop frequency: 20318.8
Frequency increment: 1/12 octave
Num frequency points: 81

Num channels: 2

Microphone not used

< Steps values >

dBV/V

Freqg(Hz) Magn (dB) Phase (deg)
200.0 0.01 0.0
212.0 0.01 0.0
224.5 0.01 0.0
237.7 0.01 0.0

2) Magnitude+Phase (plain .TXT) - contains lines with data: frequency, magnitude, phase.

200.0 0.01 0.0
212.0 0.01 0.0
224.5 0.01 0.0
237.7 0.01 0.0

3) Magnitude + distortion - has following form:

<Steps info>

Start frequency: 200.0

Stop frequency: 20318.8
Frequency increment: 1/12 octave
Num frequency points: 81

Num channels: 2

Microphone not used

< Steps values >

dBV/V

Freqg(Hz) Magn (dB) THD (%) Dist2 (%) Dist3 (%) Dist4
200.0 0.01 0.00072 0.00015 0.00061

212.0 0.01 0.00082 0.00019 0.00061

224.5 0.01 0.00083 0.00018 0.00069

237.7 0.01 0.00085 0.00015 0.00065

252.0 0.01 0.00093 0.00021 0.00070

267.0 0.01 0.00077 0.00019 0.00063
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2.8 Graph Setup and Editing
2.8.1 Graph Setup

The menu command Setup->Graph Setup or pressing button Set in right control bar or right-clicking
mouse in the plot area opens the dialog box '‘Graph Setup' (Fig. 2.20). Use this dialog box to set the
plot type and adjust graph magnitude and frequency range.

Graph Setup *

Magnitude range (dB) Freq. range (Hz) Impedance {ohm) Wiew

Graph top III High 20000 Max | 100 Pressure units |dB re 20uPa [ .83
Graph range Low

Harmonic distortion levels

Fit to graph top [Jmp b2 bz o4 (os []o&+

Ipdate Default QK

Figure 2.20 Graph setup

Miry

HIE
i

Plot type Magn + Distortion

The 'Graph Setup' dialog box has following controls:

Dynamic range (dB) section:
Graph top - enters the value of top graph magnitude.
Graph range - enters the graph magnitude range.
Fit to graph top - sets the graph top value from the current data.

Freq. range (Hz) section:
High - enters the highest frequency shown (in Hz).
Low - enters the lowest frequency shown (in Hz).

View section:
Pressure units - chooses: dB re 20uPa/V, dB re 20uPa/2.83V or dB re 1Pa/V units.
Plot type - chooses: Magnitude, Phase, Magnitude+Phase or Magnitude+Distortion plot.

Harmonics distortion levels section check boxes:
THD - shows the level of the total harmonic distortion.
D2 — shows the level of the second harmonic.
D3 - shows the level of the third harmonic.
D4 - shows the level of the fourth harmonic.
D5 - shows the level of the fifth harmonic.
D6+ - shows the level of sixth plus higher order harmonics.

Default — sets default values.
Update - updates the current graph.

Note: setup values can also be chosen by using the menu command 'View'.
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2.8.2 Editing Graph Colors and Line Style

We edit some graph values by using commands from menu 'Edit’. For changing the
presentation of the graph we use following commands:

Colors and grid style - sets graph colors and grid plotting style
Use thick pen - sets pen style to draw thick lines
Use thick grid - sets pen style to draw thick grid

Graph colors can be changed in two ways. The first is to change the color scheme from "Black"
background mode to "White" background mode. It can be done by clicking the menu View->B/W

color or by clicking the toolbar icon ¥ .

The second way to change graph colors is "user mode™. The user sets an arbitrary color for every
graph element using the dialog box 'Color Setup', shown in Fig. 2.21. You activate it by clicking the
menu Edit->Colors and grid style. The color setup is different for "Black" background mode and
"White" background mode (as shown in Fig. 2.21). The magnitude curve uses the Plot pen 1 color, the
phase curve uses the Plot pen 2 color, the harmonic distortion curves use Plot pen 2 to Plot pen 6
colors, the THD curve uses the Overlay 8 color.

Clicking the left mouse button on a named color rectangle opens the standard Windows dialog box
'‘Color' (Fig. 2.22) which serves as color picker.

Button Default restores default colors.

Note 1: If the check box 'All overlays with same color' is checked, all overlays will be plotted with
same color.

Note 2: If the check box 'Dotted graph grid' is checked, the graph grid will be drawn in dotted style.
Graph grid style is defined with three options:

o If the check box 'Dotted graph grid' is checked, the graph grid in all types of graphs will be
drawn in dotted style.

o If the check box 'Add axes tick marks' is checked, FR and Spectrum graphs axes will have
tick marks.

o If the check box 'Add subgrid on magnitude axis’ is checked, FR and Spectrum graphs will
have denser magnitude grid. This option disables the dotted grid option.

o User can adjust vertical axis in Frequency response and spectrum magnitude graphs by using
spin control ‘Top’ or by rotating mouse wheel. If the check box ‘Top magn. spin moves
graph’ is checked, the spin button ‘A’ moves plotted magnitude curve up by the step equal to
vertical grid division, otherwise the graph top margin is increased the same amount and
plotted curve moves down. The mouse wheel function follows the same behavior.
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Color Setup
Basic colors Cwverlay colors
Graph background IR Overlayl [
Graph ticks+border NG Overlay2 [
Flot pen1 I Overlay3 [0
Flot pen2 I Overlay4 [
Flot pen3 I Overlay5 [
Plot pen4 I Overlaye [
Flot pens I Overlay7 I
Flot pené ] Cverlayd |
Grid color | Overlays [N
SubGrid color ] overlay1o [N
Cursor color [ Overlay11 (I
Marker color I overlay12 [N
Graph grids Overlay13 [T
Dotted graph grid Overlay14 [
overlay1s [N
Add axis tick marks
add subgrid on magnitude axis [ All overlays use same color []
Top magn. spin moves graph
Default Ok

Figure 2.21 a) Dialog boxes for graph color setup in black background mode
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Color Setup
Basic colors Cverlay colors
Graph background [ Overlayl |
Graph ticks+border /I Overlay2 |
Flot pen1 L ] Overlay3 I
Flat pen2 I Overlay4 |
Flot pen3 I Overlays [N
Plot pen4 ] Overlaye |
Flot pens I Overlay7 I
Plot pené ] Cverlayd |
Grid color | Overlays I
SubGrid color (| overlay1o [N
Cursor colar | Overlay1l NN
Marker color I overlay12 NN
Graph grids Overlay13 [
Dotted graph grid Overlay14 |-
overlay1s [N
Add axis tick marks
add subgrid on magnitude axis [ All overlays use same color []
Top magn. spin moves graph
Default Ok

Figure 2.21 b) Dialog boxes for graph color setup in white background mode

EEEET 1

EEEEAT’
7 EEEEEN
7 EEEEAT
711 AEEEEE
77 EEEEER
17 EEEER

Custom colors:

171
171
171
_I
_I

Define Custom Colors =

ok ]| cores

Figure 2.22 Standard Windows dialog box for choosing colors
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2.8.3 Editing Plotted Curve

For editing plotted curve we use following commands:

Smooth Magnitude - smoothes magnitude in octave bands:
1/1 octave,
1/2 octave,
1/3 octave.
Scale level - scales the magnitude level.
LF box diffraction - scales frequency response with transfer function of LF loudspeaker box diffraction.
Cut below cursor - cuts plotted curve below the cursor position.
Cut above cursor - cuts plotted curve above the cursor position.

Menu commands 'Cut below cursor’, 'Cut above cursor’ and 'Scale level® are normally used to
“combine” two graphs; one for the high frequency and the other for the low frequency response.

Menu command 'Scale level® - opens dialog box (shown in Fig. 2.23) in which user enters
arbitrary level (in dB) to scale the magnitude response.

Scale Magnitude Level *

Enter value to scale magnitude in dB

Also, scale distortion level

Allowed range from -100 dB to 100 dB

Exit Apply

Figure 2.23 Dialog box 'Scale Magnitude Level'

2.8.4 Low Frequency Loudspeaker Box Diffraction Scaling

Menu item 'LF box diffraction" opens dialog box (shown in Fig. 2.24). In this dialog user enters the
form of the box (spherical, squared or rectangular), width and height of loudspeaker baffle. These
values are used for the definition of scaling transfer function W(f) that is used for the estimation of the
free field response from the response of loudspeaker that is measured mounted in an infinite baffle (or
in the near field).

STEPS uses following expression for the LF diffraction scaling transfer function :

W(f)_l+jf/f0
2+ jf/A,

where fo=42.7 / d - for sphere of diameter d, or fo=34.16 / d - for squared box of width d. These
values are obtained by numerically fitting transfer function W(f) with transfer function of a spherical
loudspeaker box. This transfer function is also called 2n/4x equalizer as it gives the difference of low-
frequency loudspeaker response in half space (2r) and response in a full space (4x). For a rectangular
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box, that has front baffle width w and height h, STEPS internally uses - as approximation - an
equivalent squared box of width d = w (h/w)*2,

LF Box Diffraction >

Box form Spherical e

Baffle width {cm)

Baffle height {cm) | 20

Corcel

Figure 2.24 Dialog box 'LF Box Diffraction'

Fig. 2.25 shows an example of the measured near field loudspeaker response (upper curve) and
estimated free-field response (bottom curve). At very lower frequencies the level difference is 6dB.
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Figure 2.25 Near field loudspeaker response (upper curve) and 2n/4n equalized response (lower
curve).

2.9 Percentage Distortion Plot

A common way to plot distortion frequency characteristics is in log-log percentage distortion plot as
shown in Figure 2.26. Figure shows distortion of small low-quality multimedia loudspeaker. We get
this plot by clicking menu command ‘View->Percentage distortion’ or by clicking toolbar icon _@.
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W Distortion (%) vs. frequency
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Figure 2.26 The window for percentage distortion plot

The log-log graph can show six curves:

THD - total harmonic distortion in % (calculated from first twelve harmonics),

D2 - the second harmonic distortion (%),

D3 - the third harmonic distortion (%),

D4 - the fourth harmonic distortion (%),

D5 - the fifth harmonic distortion (%),

D6+ - the distortion due to 6th to 12th harmonics (D6+ = 100 sqrt((Ae*+A7*+...A1%) IA%) % ).

depending on selected check box in the section ‘D% range’.

In the same section there are following controls:
Top - sets top graph margin.
Bottom - sets bottom graph margins.
Autofit - sets graph vertical margins to fit into the distortion range.

Mouse or keyboard cursor keys move graph cursor. The values of distortion at the current cursor
position are shown below the graph.

On the right graph side there is a legend for curve colors.
Controls at the bottom of the dialog box are:

Range list boxes - sets low and high frequency graph margin.

Autofit button - sets graph horizontal margins to fit in measured frequency range.
Copy button — copies graph to clipboard

Thick pen check box - sets pen style to draw thick lines
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Thick grid check box - sets pen style to draw thick grid
B/W button - check box - changes the background color to White or Black

If there is one or more overlay plots in the frequency response window, then the distortion window
shows automatically overlay check boxes (see Fig. 2.27) which allows to control the view of distortion
for the first overlay. The right plot legend shows colors of "overlay" distortion (THDo, D20, D30,
D4o, D50, D60+).

W Distortion (%) vs. frequency
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Figure 2.27 The ‘Distortion” window with a current an overlay distortion plotted
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2.10 Time Record

The time record of the last recorded signal can be seen in a "Time record' window (shown on Fig.
2.28). It can be activated by clicking the menu View->Time record, or by clicking the toolbar icon

.
% Time record — O X
File Edit
Channel
Time record (mV) Zoom 1:16 left  ~
150 = | Offset
* || Mull

VNN L
| WIRRELE
| \
\ \

Ay RIRVIRY
=50

VARV RAVIIRYER VAR VAR AYIRY
100 —¢ v U Y Y v ) v v «| | Max
-150 T -
Scroll
20 40 &0 &l 100 120 ms T

Cursor: 104641 mV, 31.083 ms (1451} Gate: 61.867 ms (Z560)

Figure 2.28 Time record of the last captured signal

The plot shows a properly scaled time record of the input signal. The yellow line denotes the cursor
position, and the red line denotes the marker position.

User sets the cursor position by pressing and dragging the left mouse key, and marker position by
pressing and dragging the right mouse key. Double clicking the right mouse button turns the marker
on and off.

The "Cursor:" label denotes the report for the magnitude of the signal at the cursor position (time in
ms or sample position - in braces). The 'Gate:" label denotes the report for the difference in time (and
in samples) between the cursor and the marker.

Buttons on the right pane serve as commands to Scroll the signal plot, to Zoom plot in and out, to
change the Gain and vertical Offset.

Zoom ratio is shown above the upper right corner of the graph. It is written as ratio p:n, where p
means number of pixels used to draw n signal samples. Maximal zoom is defined with ratio 8:1,
normal zoom is defined with ratio 1:1 and minimal zoom is defined with ratio 1:m, where m=signal
length/graph width in pixels.

Zoom commands:
Up - increases the zoom ratio.
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Down - decreases the zoom ratio.
Min - sets minimal zoom ratio (to show almost all signal samples).
Max - sets maximal zoom ratio, by following these rules:
o If marker is set, then all samples between the cursor and the marker will be shown with
maximum possible zoom ratio.
e If the marker is switched off, the plot is zoomed to ratio 1:1 or 8:1 with cursor position sets to
first graph point. (or maximum ratio 8:1 if previous zoom ratio is lower or equal to 1:1).

Gain commands:

Up - increases the gain factor.
Down - decreases the gain factor.
Min - sets minimal gain factor.
Max - sets maximal gain factor.

Offset commands:

Up - increases the vertical offset.
Down - decreases the vertical offset.
Null - sets the vertical offset to zero.

Scroll commands:

Left — scrolls the plot to the left.
Right — scrolls the plot to the right.

The 'Channel’ combo box shows the currently used channel (left or right).

You can also use following shortcut keys:

Up and Down to change the gain,

Ctrl+Up and Ctrl+Down to change the vertical offset,
Left and Ctrl+Left to scroll the plot left,

Right and Ctrl+Right to scroll the plot right,
Shift+Left and Shift+Right to move the cursor left and right,
PgUp and PgDown to change the zoom factor.

Shortcut keys are active if the graph window has focus. The focus is set by clicking the mouse in the
graph area.

Dragging the mouse in the label area scrolls the plot horizontally and vertically.

Double-clicking of the left mouse button in the time axis area toggles the time/sample position
labeling.

Menu commands are;

File

Edit

Export ASCII - saves time and amplitude data in textual file.
Info - opens message box that shows the signal RMS value and crest factor.
If the marker is set, the RMS value is determined for the gated part of the signal.

Copy - copies graph window to clipboard.

BW background color — changes background color to black or white.
Thick pen - sets pen style to draw thick lines.

Thick grid - sets pen style to draw thick grid.
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3. Using STEPS for stepped-amplitude testing

Stepped-amplitude testing is a measurement method in which we measure system response and
distortion as a function of the excitation signal amplitude. The excitation signal is the sine or two-sine
signal with a user-defined frequency. The amplitude of the excitation signal is changing from lowest to
highest value in a predefined number of measurement steps.

In stepped-amplitude mode, STEPS can measure and graphically show three functions:

1) Distortion vs. amplitude (harmonic and intermodulation distortion as a function of signal
amplitude).

2) Linearity function (system output or system gain as a function of the input excitation
amplitude) .

3) Loudspeaker displacement/distortion (combined measurement of displacement with optical
laser device and distortion with microphone)

4) Loudspeaker distortion limited maximum SPL (in user defined frequency range)

First two type of measurements are primary targeted to measurements of power amplifiers, audio
compressors and automatic gain control systems, while third type of measurement is for measurement
of loudspeaker response.

3.1 Distortion vs. Amplitude Testing

For the Distortion vs. amplitude, testing the user interface is shown in the window ‘Distortion vs.
amplitude’ (shown in Fig. 3.1). This window is opened by the menu command ‘Record->Distortion
vs. amplitude’.

F= Distortion vs. amplitude (untitled.vsd)

File Edit
General distortion measurement
) e
THD - ] Distortion (%)
[~
Response channel  |Left E
p
Sampling rate 100 s
Hz) 43000 d
Excitation sine voltage range
1.0
Frequency (Hz) 1000
Start value (Vrms) 0.001
| o001 ] g
Stop value (V rms) 01
(max<0.631V)
Use logarithmic steps 0.01
Mumber of steps
. 0.001
Integration constants 0.0001 0.001 0.01 0.1 10
Intg. time (ms) Woltage (V rms)
Transient time (ms) Record Setup Overlay Copy BfW Thick Pen [] Thick Grid

Figure 3.1 Distortion vs. amplitude window

38



Measurement of distortion is a single channel measurement. We measure system response to sine
signal and estimate distortion (THD or IMD) from that signal, the same way as we do in the swept-
sine mode. The measured system must be excited with STEPS sine or two-sine signal generator.

The graph shows the percentage of distortion as a function of the measured signal RMS voltage.
Alternatively, the graph can show the percentage of distortion as a function of the estimated value of
RMS voltage on the output of the power amplifier. It is a product of the playback lineout RMS value
and Power Amplifier Gain (as defined in Audio Devices Setup Dialog).

The measurement setup is defined in three sections:

General distortion measurement section
First Combo box is used to define what type of distortion will be measured:
THD - total harmonic distortion with user defined excitation frequency,
DIN IMD with two-sine excitation on 250 Hz and 8 kHz,
SMPTE IMD with two-sine excitation on 60 Hz and 7 kHz,
CCIF IMD with two-sine excitation on 13 and 14 kHz,
CCIF IMD with two-sine excitation on 19 and 20 kHz.

Response channel - chooses input on Left or Right channel.
Sampling rate - chooses sampling rate in Hz.

Excitation sine voltage range section
Frequency (Hz) — enters frequency for measuring THD.
Start value (V rms) - enters starting (minimal) RMS voltage value.
Stop value (V rms) - enters ending (maximal) RMS voltage value (in parenthesis a maximum possible
value, for a given Power Amplifier Gain, is shown).
Use logarithmic step — check box to use logarithmically spaced amplitudes.
Number of steps — enters number of steps of stepped amplitudes.

Integration constant section
Intg. time (ms) - enters integration time used for RMS value estimation.
Transient time (ms) - enters time that is needed for system to reach the steady state. It can be from
several ms to more than 1000 ms. The larger values are appropriate for measuring audio compressors or
circuits with automatic gain control.

Bottom buttons
Record - starts/stops the measurement.
Copy - copies the current graph to the clipboard in .bmp format.
B/W - changes the current graph background color to black or white.
Setup - opens the dialog for Graph setup.
Overlay - opens the dialog for overlay manipulations
Thick pen - sets pen style to draw thick lines.
Thick grid - sets pen style to draw thick grid
Cancel - closes the window and discards current measurement setup.
OK - closes the window and saves the current measurement setup.

The window has two submenu items: File and Edit.
File commands are:
Open - retrieves data from binary (.vsl) file.
Save - saves data in binary (.vsl) file.
Export... - saves data in textual files in plain ASCII or Excel CSV format.

Edit commands are:

B/W — changes graph background color to black or white.
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Copy - copies graph in Windows clipboard.
Thick pen - sets pen style to draw thick lines.
Thick grid - sets pen style to draw thick grid.

The right mouse click in the graph area (or click on button Setup) opens the dialog box ‘Distortion
graph setup’. It is shown in Fig. 3.2.

Distortion graph setup >

Axis type Y -axis range ¥-axis range

Log Y-axis Distartion (%) High (V)
Log X-axis Mum decades |5 “ Low (v} | 0.0001

X-axis
measured Update Default Cancel

Figure 3.2 Dialog box Distortion graph setup

Dialog box Distortion graph setup’ has following controls:

Axis Type section

Log Y- axis — sets logarithmic or linear Y-axis.

Log X- axis — sets logarithmic or linear X-axis

X-axis measured - check box to set x-axis labeling to measured or estimated RMS value (the measured
value is RMS value measured at soundcard input, and the estimated value is RMS playback value on line-
output multiplied with Power Amplifier Gain).

Y-axis range section

Distortion (percentage) - enters the range or maximum value of percentage distortion.
Num decades - chooses number of decades below maximum value that are shown in the log-plot.

X-axis range section

High (V) - enters maximum RMS voltage shown on x-axis.
Low (V) - enters minimum RMS voltage shown on x-axis

Every graph curve can be set as an overlay curve. An example is shown in Fig. 3.3. That figure also

shows dialog box Distortion Overlays that serves as an overlay manager. Manipulation with overlays
is the same as with overlays in main window, described in the Section 2.6.
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R Distortion vs. amplitude (untitled.vsd)

File Edit

Distortion Overlays

General distortion measurement

|CCIF IMD (13420 kHz) = | Distortion (%) File Colar
w untitied THD -
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Intg. time {ms) 300 Crsr:0.0050%, CCIF1S IMD:0.0027% Voltage (V' rms)
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Integration constants

Figure 3.3 Distortion graph and Distortion overlay manager
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3.2 Linearity Testing

For the linearity measurements, we use the user interface defined in the window ‘Linearity Function’
(shown in Fig. 3.4). This window is opened by the menu command ‘Record->Linearity function’.

v Linearity Function (untitled.vsl)

File Edit
Measurement channels
¥ - channel Left il 100 Response (Vrms) Linearity test
: 3
% - channel Right b T
E
Sampling =
rate (Hz) 43000 i 10 5
Excitation sine voltage range
— .
Start value (Vrms)
Stop value {V rms) -
(max<0.631V) m 0.m
|Jse logarithmic steps
Mumber of steps 0,001
Power reduction -
(duty cyce) -
: 0.0001
Integration constants 0.0001 0.001 0.01 0.1 1.0 10.0
Intg. time (ms) 300 Excitation (vrms)
SEmEEs Recard Setup Overlay Copy B/ Thick Pen Thick Grid [_]

Figure 3.4 Linearity Function window

Linearity testing is a dual channel measurement. We measure some system excitation as X signal and
the system response as Y signal. The excitation signal is generated by STEPS sine signal generator.

The measurement setup is defined in three sections:

Measurement channels section
Y - channel - chooses soundcard line-input channel for measuring system response.
X — channel - chooses soundcard line-input channel for measuring system excitation.
Sampling rate - chooses sampling rate in Hz.

Excitation sine voltage range section
Frequency (Hz) — enters sine frequency.
Start value (V rms) - enters start (minimal) RMS voltage value
Stop value (V rms) - enters ending (maximal) RMS voltage value (in parenthesis a maximum possible
value, for a given Power Amplifier Gain, is shown).
Use logarithmic step - check box to uses logarithmically spaced amplitudes.
Number of steps - enters number of steps of stepped amplitudes.
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Power reduction (duty cycle) — enters number in the range 2 to 50, which represents the ratio of the
duration of generated signal + pause and duration of generated signal signal in one step. It is proportional
the ratio of peak signal power during signal generation to total output signal power.

Integration constants section
Intg. time (ms) - enters integration time used for RMS estimation
Transient time (ms) - enters time that is needed for system to reach the steady state. It can be from
several ms to more than 1000 ms. The larger values are appropriate for measuring audio compressors or
circuits with automatic gain control.

Bottom buttons
Record - starts the measurement. If pressed during the measurement this button stops the measurement.
Copy - copies the current graph to the clipboard in .bmp format.
B/W - changes the current graph background color to black or white.
Setup - opens the dialog for Graph setup.
Overlay - opens the dialog for overlay manipulations.
Thick pen - sets pen style to draw thick lines.
Thick grid - sets pen style to draw thick grid.
Cancel - closes the window and discards current measurement setup.
OK - closes the window and saves the current measurement setup.

The window has two menu items:

File commands are:
Open - retrieves data from binary (.vsl) file.
Save - saves data in binary (.vsl) file.
Export... - saves data in textual files in plain ASCII or Excel CSV format.

Edit commands are:
B/W — changes graph background color to black or white.
Copy — copies graph in Windows clipboard.
Thick pen - sets pen style to draw thick lines.
Thick grid - sets pen style to draw thick grid.

The right mouse click in the graph area (or click on button Setup) opens the dialog box ‘Linearity
graph setup’. It is shown in Fig. 3.5.

Linearity graph setup X

Axis type Y-axis range ¥-axis range

DRy v —_—
DSh?;é?E?VE min (dBV) Kmin (dBV)
Update Default Cancel

Figure 3.5 Dialog box Linearity graph setup

Dialog box ‘Linearity graph setup’ has following controls::

Axis Type section
Show Log V (or dBV) - check box to set logarithmic or dB Y-axis
Show relative (dB V/V) - check box to use linearity function as Y/X vs. X.

Y-axis range section
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Ymax (dBV) - enters maximum of shown level or transfer function (depends on the state of the check
box Show relative).

Ymin (dBV) - enters minimum of shown level or transfer function (depends on the state of the check box
Show relative).

X-axis range section
Xmax (dBV) - enters maximum of shown input level.
Xmin (dBV) - enters minimum of shown input level.

3.3. Displacement and Distortion Testing

The estimation of a peak acoustic power, which can be generated from some loudspeaker driver, is
based on the loudspeaker voice coil peak displacement, usually denoted as Xmax. Here a method for
measuring Xmax Will be presented. During the measurement various types of distortion will be
measured and presented graphically (harmonic distortion: THD, D2, D3, and intermodulation
distortion: MD2, MD3).

3.3.1 Definition of Xmax

AES recommendation 2-1984 defines the Xmax as "the voice-coil peak displacement at which the
linearity of the motor deviates by 10%. Linearity may be measured by percent distortion of the input
current or by percent deviation of displacement versus input current. Manufacturer shall state method
used. The measurement shall be made in free air at fs."

This definition is not quite clear, and effort has been made to introduce a new standard for definition
and measurement of Xmax. This new draft standard is available now as: "IEC PAS 62458: Sound
System Equipment — Electroacoustical transducers — Measurement of large signal parameters".

This standard is based on the W. Klippel's definition for Xmax:

""The voice-coil peak displacement Xmax at which either the total harmonic distortion THD or the nth-
order modulation distortion (where n=2 or 3) exceeds 10% in the sound pressure radiated by the
driver in free air excited by the linear superposition of a first tone at the resonance frequency f1=fs
and a second tone f,=8.5 fs with an amplitude ratio of 4:1. The total harmonic distortion assesses the
harmonics of f; and the modulation distortion are measured by the modulation components f, = (n-1) f;
according to IEC 60268".

3.3.2 Measurement of Xmax

Following previous definition, STEPS gives user interface for practical measurement procedure that is
being executed as follows:

1. Mount the driver in a free field and measure resonance frequency fs of the driver.

2. Use measurement setup with two sensors:
- microphone, that is placed in a driver near field, connect to the one input channel, and
- optical laser devices, that can measure voice-coil displacement, connect to the other input
channel.

3. Connect input of a driver's power amplifier to the soundcard left output channel and excite the
driver with a two-tone signal f;=fs and f,=8.5fs and with amplitude ratio U;=4U and perform a series
of stepped-amplitude measurements with Ustart < U; < Uend.

4. Measure the peak displacement spectral component Dy(f1), and spectral content of the sound
pressure in the near field, versus amplitude Ui1. For each amplitude U; determine:
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- amplitudes of fundamental tones P(f;) and P(f.),
- harmonic components P(k f;) with k=2, 3, ...,K, and total harmonic distortion

THD=100\/ P2(2f1)2+P2(3f1)2+..2+ P(Kf)? )
P(f,)? +P(2f)* + P(31)? +..+ P(KF)

- second-order and third-order modulation distortion
MD, =100 P(f,+ f)+P(f,— 1) %), MD, =100 P(f,+2f)+P(f,-2f1)
P(f,) P(f,)

5. Search for the minimal value of the excitation voltage U1 (in the range Ustart < Uig < Uend)
where either the THD, MD2 or MD3, respectively, equals 10%.

(%)

6. Find the peak voice-coil displacement Xmax as a displacement that correspond to the amplitude U1gs.

Right out )
power amplifier
microphone
Left out [ — —
soundcard loudspeaker laser
Right input |« Q —
Left input |- 1} l
Q preamplifier

Fig. 3.6 Two-channel measurement setup for loudspeaker pressure response and voice-coil
displacement measurements. The excitation signal is a stepped-amplitude two-tone signal.

45



STEPS User Manual

Figure 3.7. Positioning of laser displacement sensor and microphone

3.3.3 STEPS User Interface for Measurement of Xmax

For the simultaneous measurement of loudspeaker distortion and voice-coil displacement, STEPS
gives us a user interface in the window ‘Displacement/Distortion Function’ (shown in Fig. 3.8). This
window is opened by the menu command ‘Record->Loudspeaker displacement/distortion’.

R Distorton and Displacement (untitled.vd:)

File Edit
Measurement channels
Response channel | Left w
Distortion (%) Displacement (mm peak)
Sampling rate (Hz) |48000 0 70 10,0
LUse displacement sensor i
v 18.0 D3 5.0
on other channel -:L
Sensitivity (mV/mm) 16.0 8.0
Excitation sine voltage range 14.0 7.0
Start val 0.1
rt value {V rms) - 120 60
Stop wvalue (V rms) 10
(max<0.5204) - 10.0 50
Mumber of steps
2.0 4.0
|:| Logarithmic step increment
THD break value (3t) 8.0 3.0
Sine frequencies 4.0 2.0
Frequency f1 (Hz) 50
E] s o
[Flusef2= a.5f1 (U1=40U2)
0.0 0.0
Integration constants 0.1 2.1 4.1 6.0 8.0 10.0
Vot )
Integration time (ms) 300 oftage (\/rms)
Transient time {ms) 50
- Record Setup Copy B Thick Pen [  Thick Grid []
|

Fig. 3.8 Distortion and Displacement measurement window

Window ‘Distortion and displacement * has following controls::

Measurement channels section:
Response channel - chooses the microphone input channel.
Sampling rate (Hz) - chooses the current sampling frequency.
Use displacement sensor on other channel - check if sensor for the displacement measurement is
connected to the other input channel.
Sensitivity (mV/mm) - enters sensitivity of displacement sensor.

Excitation sine voltage range section:
Start value (V rms) - enters stepped voltage amplitude start value.
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Stop value (V rms) - enters stepped voltage amplitude stop value. The maximum value is denoted
below this control (a power amplifier output voltage is reported).

Number of steps - enters number of repeated measurements with voltage increment.
Logarithmic step increment - switches voltage steps to logarithmic increment.

THD break value (%0) - enters limiting value for distortion, after which measurement stops.

Sine frequencies section:
Frequency f1(Hz) - enters fundamental frequency for harmonic distortion measurement.
Use f2 = 8,5f1 (U1=4U2) - check box to use intermodulation distortion measurement.

Integration constants section:
Integration time (ms) - enters RMS detector integration time.
Transient time (ms) - enters transient time, as time necessary to reach the steady state condition.

Bottom Buttons
Record - starts or stops measurements.
B/W - changes background color to black or white.
Copy - copies graph to clipboard.
Thick pen - sets pen style to draw thick lines.
Thick grid - sets pen style to draw thick grid.

Click on button 'Setup’ or right mouse click in the graph area opens the dialog box ‘Distortion/displacement
graph setup’. It is shown in Fig. 3.9.

Distortion/displacement graph setup X

Axis type Y-axis range ¥-axis range

(%e)
Log X-axis [] Displacement Low (V)
(mm)

Mum

decad
seans [ ]show 2nd and 3rd harmonic distortion

pdate Default oK

Fig. 3.9 Dialog box for Distortion/displacement graph setup

Dialog box ‘Distortion/displacement graph setup’ has following controls:

Axis Type section
Log Y- axis - sets logarithmic or linear Y-axis.
Log X- axis - sets logarithmic or linear X-axis.
Num decades - chooses number of decades in logarithmic Y-axis.

Y-axis range section
Distortion (%) - enters Y-axis range for distortion graph.
Displacement (mm) - enters Y-axis range for displacement graph.

X-axis range section

High (V) - enters voltage for the graph right margin.
Low (V) - enters voltage for the graph left margin.
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If check box 'Show 2" and 3" harmonic distortion' is checked the graph shows additional distortion curves.

The window has two menu items: File and Edit.

File commands are:
Open - retrieves data from binary (.vdx) file.
Save - saves data in binary (.vdx) file.
Export... - saves data in textual files in plain ASCII or Excel CSV format.
Info — shows information about current file.

Edit commands are:
B/W — changes graph background color to black or white.
Copy - copies graph to Windows clipboard.
Thick pen - sets pen style to draw thick lines.
Thick grid - sets pen style to draw thick grid.

Distortion (%) Dizplacement (mm peak)
0 10.0
=
18.0 7 3.0
16.0 8.0
14.0 7.0
12.0 6.0
10.0 5.0
8.0 40
6.0 3.0
4.0 20
2.0 1.0
0.0 0.0
0.0 16 3.2 48 6.4 8.0
Crer6.5V, THD:16.4%, Dx:B.2mim Voltage (Vrmns)

MD2:2 BT 3647%, MD3:4.969189%

Fig. 3.10. Example of measurement results. For displacement measurement a laser sensor type
Baumer OADM 2016441/S14F is used.

The Fig. 3.10 shows results of measurement where dominant distortion type was harmonic distortion.
The comparison of displacement and THD curves shows that in this case Xmax = 5mm.

Measurement data can be saved in file. Two formats are possible: textual file and binary file that has
name extension ".vdx".

3.4 Loudspeaker Distortion Limited Maximum SPL

Loudspeaker maximum SPL is a sound pressure level of sine signal that can be achieved under
condition that THD of signal radiated from loudspeaker is below the user defined threshold (usually
10%).
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Important notice: It is of great importance to follow the proposed measurement procedure,
otherwise measured loudspeaker can be severely damaged. Here we work with high sound
pressure. It is recommended that you protect your ears. Please, use professional microphones
that linearly transduce large sound pressure.

Figure 3.11 shows measurement setup. A loudspeaker is driven by power amplifier that is connected
to the soundcard left output channel. Power amplifier has volume control. Output from the
loudspeaker is recorded by microphone connected on soundcard left input channel. Power amplifier
output voltage, scaled by resistive voltage divider (R2/ (R1+ R2)) is recorded using soundcard right
input channel. Value of divider resistors depends on power amplifier rating. For 200W amplifiers, that
has 40VVrms maximum output voltage we can use divider with R1=3900Q2 and R2 = 10002, and set
probe gain of 100/4000=0.025 in Device Setup - Right preamplifier gain edit box.

power
amplifier loudspeaker

Left out —
microphone
soundcard
Right input
) R2
Left input I
preamplifier

Figure 3.11 Hardware setup for measurement of distortion-limited levels
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R Distortion Limited Levels {untitled.spmj}
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Figure 3.12 'Distortion Limited Levels' measurement window

User has to set the testing sine frequency, THD limit (in %), level step (0.5, 1, 1.5 or 2 dB) and adjust
maximum dynamic range (30, 36, 40 or 46 dB) for chosen power amplifier. For example, if user
choose dynamic range of 30 dB then testing will be done for soundcard output levels from -31 to -1
dBFS. Before the measurement, user is responsible to adjust power amplifier volume control so that
generator level of -31 dBFS gives power amplifier output voltage that is 31 dB (or 35.5 times) lower
that amplifier maximum voltage, i.e. for 200 W amplifier with maximum output rms voltage of 40 V
user have to set volume control to obtain 40/35.5 = 1.12 VVrms at amplifier output when generator level
is -31dBFS. For this purpose, user can use dialog box Measurement Setup as level controlled sine
signal generator.

If user does not set amplifier volume control properly, there is a chance of pushing power

amplifier output to clipping. If STEPS works in dual channel mode, the clipping is checked and
reported to user.

Window ‘Distortion Limited Levels’ has following controls:

Measurement channels section:
SPL channel - chooses the microphone input channel.
Measure excit. voltage — check to record power amplifier output and amplifier clipping.
Sampling rate (Hz) - chooses the current sampling frequency

Excitation sine range section:
THD limit (%) - enters distortion threshold
Start freq. (Hz) - enters starting frequency
Stop freq. (Hz) - enters highest frequency
Freq. resolution - chooses fractional octave frequency increment in one measurement step.
Level step (dB - chooses magnitude increment in one measurement step.
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Dynamic range (dB) - chooses maximum dynamic range for level testing (30, 36, 40 or 46 dB).

Power reduction factor (2-1000) - enters number in the range 2 to 1000, which represents the ratio of
the duration of generated signal + pause and duration of generated signal in one step. It is proportional
the ratio of peak signal power during signal generation to total output signal power.

Integration constants section:
Transient time (ms) — enters transient time, as time necessary to reach the steady state condition
(integration time is always approximately equal to200ms).

Bottom Buttons
Record - starts the measurement. If pressed during the measurement this button stops the measurement.
Copy - copies the current graph to the clipboard in .omp format.
B/W - changes the current graph background color to black or white.
Setup - opens the dialog for Graph setup.
Overlay - opens the dialog for overlay manipulations.
Thick pen - sets pen style to draw thick lines.
Thick grid - sets pen style to draw thick grid.
Cancel - closes the window and discards current measurement setup.
OK - closes the window and saves the current measurement setup.

The window has two menu items:

File commands are:
Open - retrieves data from binary (.spm) file.
Save As - saves data in binary (.spm) file.
Export... - saves data in textual files in plain ASCII or Excel CSV format.

Edit commands are:
B/W - changes graph background color to black or white.
Copy - copies graph in Windows clipboard.
Thick pen - sets pen style to draw thick lines.
Thick grid - sets pen style to draw thick grid.
Scale level - Opens dialog for entering the Scale in dB for shifting the current level

The right mouse click in the graph area (or click on button Setup) opens the dialog box ‘Graph
Margins’. It is shown in Fig. 3.13.

Setup of Power reduction factor is very important, as it can save us from burning the
loudspeaker. If loudspeaker has declared long term power P and testing will be done with power
amplifier that can generate power Pmax, We must set power reduction factor to value Pmax/P.

When testing tweeters use even larger power reduction factor. It is best that you assume that
tweeter can withstand only 1-2 W of continuous power.

Graph Margins >

Frequency range SPL range (dB re 20uPa) Excitation voltage (dBV)

Low {Hz) Range (dg) | 100 Range (dBv) | 50

Showe excitation voltage pdate Default Cancel 0K

gugs

Figure 3.13 Dialog box Graph Margins
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Dialog box ‘Graph Margins’ has following controls:

Frequency range section
High (Hz) - enters maximum frequency for right graph margin.
Low (Hz) - enters minimum frequency for left graph margin

SPL range (dB re 20uPa) section
Top (dB) — enters top margin in dB for SPL graph
Range (dB) — enters SPL graph range in dB

Excitation Voltage (dBV) section
Top (dBV) — enters top margin for excitation voltage graph, in dBV
Range (dBV) — enters graph range for excitation voltage, in dBV

Show excitation voltage - check to show plot of excitation voltage in dBV
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